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1. Introduction                                                                  
 
1.1 Brief introduction of 701 Server and 701 Client  
 
701 Server and 701 Client are multiple language and true 32-bit software package that runs 
under Windows 98, 2000, NT and XP, and is for all SOYAL Proximity Access Control off-line 
networking systems. 
 
The 701 Server is a dedicated software program that provides with mainly communication port 
selection, data collection, system components physical connection, and all the controller’s 
parameter settings. With the TCP/IP remote access ability, this feature can support remote 
location configuration and data collection. Through the NetBEUI protocol and Local Area 
Network, the Server Computer and Client Computers can be spread throughout many offices 
and buildings; authorized users can monitor the system by using either Server Computer or 
Client Computer in their offices. 
 
The 701 Client is a software program that dedicates the software tools for Door Access Control, 
Time & Attendance, Payroll, Elevator Control, Car Park Control, Access Records Reports, Time 
& Attendance Daily/Monthly Reports, Projects Management and Operators Authority Level 
Control. System also provides with the ability to import bitmap files for photos. 
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1.2 Menu Bar content           
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
1.3 Tool Bar content  
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2. Installation                                                                     
 
Step 1: Insert the CD to CD-ROM. Run file [ 701ClientSetup.exe ] and follow the instructions    

to install the 701 Client. 

    Step 2: Operator can execute from Start \ Programs \ Soyal Software \ 701 Client. 

  Step 3: From the window desktop, click 701 Client Icon. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The system will ask to login.   
 

 There are two sets of default login. One is [ supervisor ] (Operator 1), the other is   
    [ soyal ] (Operator 99). Please note the factory settings both on the [Login Name]    
    and [Password] is [ supervisor ] or [ soyal ]. 

 Click Login to exit. 
 
Note that after initial login the Client, for your safety, please always change a new Login Name and 
Password with Access Level 63 for your future login. 
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3. Operator Management                                                          
 
Choose Password under the Help menu item, then as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
After initialing login with the factory settings (the highest level), users can reset their own favorite 
[ Login Name ] and [ Password ]. The Steps are as follows: 
 

 Select [ User ID ]. 
 Select Access Level. (See Also: Access Level under the Setting menu item) 
 Select a favorite [ Login Name ] and [ Password ]. 
 Select this user can use which function. 

    These functions are used with together User Level for authority management. 
    For example, in the Password edit, user A click Door Access function and user level “55”.  
    In the Access Level edit, Card/POP is 50 level for modification, Door Group is 50 level for 

modification and Time Zone is 50 level for modification. 
    Then, access level of user A is higher than Card/POP, Door Group and Time Zone level. So, user 

A can edit Card/POP, Door Group and Time Zone function after login 701 Client.   
 Click [Yes] to complete NEW settings. 

Note:  
1. The [ Login Name ] and [ Password ] consist of any combination of up to 18 characters or 9 Chinese 

characters. Access Level means a limitation of authority to access the 701 Client, the range is from 

0 ~ 63. Access Level 63 is then highest management. Rank access levels from high to low in order 

of numerals, and 0 is the lowest access levels. The system can support up to 100 Operators that the 

highest management is also included. 

     2. Only the operator with Access Level 63 can log in to add/delete/modify other operators. Operator  

with Access Level lower than 63 can log in to see only its own Login Name and Password. 

3. Limit Card Edit Range (1 - 199) function is suitable for building security guard edit temporary card 

for visitor. When the operator with Limit Card Edit Range (1 - 199) function log in 701 Client, he just 

can set user address from 1 to 199 in User Card Edit and the system automatically assign on that 

day to access deadline when download. (See Also: User Card Edit) 
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4. Access Level                                                                 
 
Function: For each menu’s function, it can be viewed or  

modified or accessed advanced features. Based on these three  

activities, an operator with particular Access Level can operate 

one or more activities that have been assigned to that level, or  

below. These settings are related with login level. 

Click on the toolbar Access Level Edit icon  as shown right. 

Item description as follows: 

(1) Card / POP option means use card edit and import bitmap files 

for photos. 

(2) Door Group option means door group edit. 

(3) Time Zone option means time zone edit. 

(4) Holiday option means holiday edit. 

(5) Attendance option means attendance edit. 

(6) Door Name option means door name edit. 

(7) Download option means download data to controller. 

(8) Save Text option means Save to Text, Files to Text and Time Attendance Export Format under the 

Tools menu item. 

(9) Message option means daily transaction record. 

(10) Report option means daily time and attendance report, multi-day time and attendance report and 

multi-day time and attendance summary report. 

(11) Reader CTL option means reader status monitor and modify function. 

 Login level of the operator is higher or equal than  and lower than .  

The operator can view only. 

 Login level of the operator is higher or equal than  and lower than .  

 The operator can view and modify. 

 Login level of the operator is higher or equal than .  

   The operator can modify and access advanced such as the Tools  menu item of User 
Card Edit window and click row twice can enter the editing on Daily Time and Attendance 
Report window. 

 Click Save to save all the settings to the current work file. 

Save As: Save all the settings to another file. 

Exit: Click exit to Quit. 
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5. User Card Edit                                                                

  Click on the toolbar User Card Edit icon . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.1 Basic user data settings 
5.1.1 Edit one card 

 Assign a unique User Number to each user card. 

  User Number 0 is for special use, such as for master cards. User can enter reader Edit Mode by 

just flashing card with User Number 0 to the reader (in "Card only" access mode). After access 

successfully, in 3 seconds, press <F2> function key to enter Edit Mode. 

 Enter Card ID. 

Sitecode: There is a 10-digit number on each card, enter the left-most 5 digits Sitecode. 

Cardcode: There is a 10-digit number on each card, enter the right-most 5 digits Cardcode. 

 

 
 
 
 
 
 
   
    Or click “Auto Save CardID” function to deliver card ID to PC automatically by flash card on the  

device.  
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 Enter the cardholder User Name, max. 28 characters. 
 User Card can select one of the Access Modes. Select Invalid to disable the User Card. 
 Enter User’s Department Name, max. 20 characters, max. 350 Dept. Names. 

The system provides two columns for Department Name; it is suitable for some dept. is being 
subdivided into many teams. For example, there are design dept. and product dept. under sales 
dept.   

 Click  to save all the user settings to the current work file. 

 There are two ways to download data to controller. One is to download the content of one card 

    by clicking  icon on the page of user card edit. The other is to download the content of all  

cards by clicking the toolbar download to controller icon .   

 Click  to exit. 

 
5.1.2 Edit sequential CardID  

Within a specified card range, user can copy cards that same as the current shown User Card setting 

based on the selected topic(s). 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Select user number that is based on the card of desired copy.  

 Choose Card Copy under the Tools  drop down menu.  

 Setting Card Copy range. 
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 Click that same as the current shown User Card setting based on the selected topic(s) as desired. 

Besides, Card Code will be increased by 1 for each continuous address. The others function is 

the same with current shown User Card setting. 

 Click [ YES ] to exit.   

For example, it is based on user number 1 to copy from user number 1 to 50. Then, you will find  

access mode and department is the same with user number 1 from user number 1 to 50. But card  

code is increased by 1 for each continuous address, card code of user number 1 is “64815”, card code  

of user number 2 is “64816”, card code of user number 3 is “64817”. 
 
5.2 Advanced user data settings 
(1) Alias: enter English name (max. 20 characters ) in Alias column and click Alias / Begin Date under 

Tools  menu of user card edit or click Alias / Start Date item on  here to download 

Alias to controller. There, after the user flashes card, on the screen of the item AR-829E / AR-821EF 
will be shown “ user’s alias”. 

(2) User Picture: Click twice. When the open window opens, select the path of the picture 
   as desired. Then the system will save the picture named by [ Userxxxx.jpg ] to the default path 

[ C:\Program Files \ 701 Client \ popgra ] Note that xxxx is user number. (Quality 400*420) 
(3) Zone: Enter ALL or 01 ~ 63. Assign the first Time Zone Number of a chain. ‘ALL’ means no Time 

Zone Control. 
(4) Group: ALL or 001 ~ 255. Assign the initial Door Group Number of a chain. “ALL’ means no  

Door Group Control. 

(5) Level: Enter this user access level, 00 ~ 63.  
Function: User A can access the door C with Card and PIN in time zone B; User A can access the 
door C with Card only in time zone D. The steps as follows:  
In “Card and PIN” Access Mode, User Card can access the door with Card Only if its level is 
higher than both Time Zone Level and Door Group Level; can access the door with Card and PIN 
if its level is equal to both Time Zone Level and Door Group Level; can’t access the door if its level 
is lower than Time Zone Level or Door Group Level.  

(6) P.I.N. Code / Variable: If chose variable item and enter 4-digit in P.I.N Code, cardholder can 

change the PIN Code from the reader panel. This function is good for “Card or PIN” and 

User Level  Zone Level Door Group Level  Access Mode 
1 0 0 Card Only 
1 1 0 Card and PIN 
1 0 1 Card and PIN 
1 1 1 Card and PIN 
1 0 2 Cannot access 
1 2 0 Cannot access 
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“Card and PIN” Access Modes. After card accessed successfully, in 3 seconds, user can 

press 4-digit new PIN Code twice and then press # sign to change a new PIN Code. 

P.I.N. Code: 0001 ~ 9999, 4-digit PIN Code for “Card or PIN” and “Card and PIN” Access 

Modes. Please don’t assign the PIN Code that same as Duress Code. 

(7) Employ ID: Enter up to 18 characters. 

(8) Data Limits: Defined the User expired date. Click Alias / Begin Date under Tools  menu of 

user card edit or click Alias / Start Date item on  here to download deadline to controller. 
(9) Anti-pass-back: If chose, User Card has anti-pass-back feature. 
(10) Guard: Check this item. It is for patrol tour using. Daily transaction record will be displayed 

according to patrol data. 

(11) Skip FP Check: Once this item is chose, this user doesn’t need to access the door with 

using fingerprint on the AR-821EF device. 

(12) Duty #: Select the duty time of this user from drop down menu. These duty time are edited in       

attendance edit in advance.  

(13) Car ID: Enter up to 14 characters. 

(14) VisaID: Enter up to 18 characters. 

(15) Gender: Select Male or Female from drop down menu. 

(16) TEL: Support two sets of telephone number. Enter up to 18 characters. 
(17) Addr.: Enter up to 58 characters. 
(18) E-mail: Enter up to 58 characters. 

(19) Clear one user data: Click this icon , then user data of this page will be cleared. 
(20) Lock: Remembering to click this item when the operator edits user data, this function is to   

avoid the window jump the window of this person to due to someone flash card. 

(21) Save As.: Choose Save As. under the Tools  drop down menu. Click Save As. to  
    save all the User Cards settings to another file. 

(22) Download Alias / Begin Date: Click Download Alias / Begin Date under the Tools     

     drop down menu. Then alias of current card user will download to controller. 

   This function applies to product item AR-821EF/AR-829E.  

   For AR-821EF, only user number 0 – 4999 can display name on the screen, but user number     

   4999-9999 cannot display.  

   For AR-829E, user number 00000-15,000 can display name on the screen. 

  For AR-821EF, the beginning date of expired Limit is restricted to user number 0 – 4999 only,    

  and user number 4999-9999 is only controlled by the ending date of expired Limit. 
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  For AR-829E, limits date between start and end of user number from 00000 to 15,000 is enable.  

(23) Keywords search: Enter keywords in blank column and click search icon . 

    Then, the searching result will be displayed the following table.  

    The Steps as follows:    

 

 

 

 

 

 

 

 

 

 

 

 

 

 Enter keywords. 

 Click “Search” icon. 

 At the bottom of the window will display the data of searching key words. 

    Then user can click row twice to see its contents. 

(24) Card Search: This function is to search according to right picture item. The Steps as follows:   
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 Select user number that is based on the search.  

 Choose Card Search under the Tools  drop down menu.  

 Setting Card Search range. 

 Click searching item. 

 Click [ YES ] to exit.   

 At the bottom of the window will display the data of searching key words. 

    Then user can click row twice to see its contents. 

For example, it is based on user number 1 to search which one is sales dept. from user number 1 to  

50. The result is that sales dept. consists of Tom, Caven and David. 

 

(25) How to know how many users in the system now?  
 

See this icon  to know there are already 10 users in the system, but no including 

that access mode is invalid card. 

 

5.3 How to download user database to the reader or upload user database from the reader? 
 
Case1: In standalone 701H3, 701HP3, 721H, 727H systems, the User Cards settings can be edited 

on computer or from reader panel, and by using this menu through the 701E/716EV2/716Ei controller 

to download/upload the cards settings to/from the selected Readers. If user want to copy same user 

cards settings from one reader to many others readers, or if user want to save all the cards settings of 

standalone readers that edited by reader panel, then use this feature is the right choice. (Option: 

701H3/701HP3, 721H/727H Standalone-1000 Users ) 

Case 2: In networking 701H4-375, 721H, 727H systems, the User Cards settings can be edited on 

computer, and by using this menu through the 701E/716EV2/716Ei controller to download the cards 

settings to the selected Readers. When the reader is off-line with the controller, the reader will become 

standalone reader. (Option: 701H4-375, 721H/727H Networking-Group Filter) 

Case 3: Once the PC crash, all user databases are lost, we can upload user database from controller 

to PC. (Option: 716E/727E & 716EV2/727Ei, 821E/829E) 
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 Choose Read / Write to 701H under the Tools  drop down menu. 

 Select to download/upload the cards settings to/from the selected controller and reader. 

    Two matters needing attention:    

    (1) Every reader must be set unique Node ID. The reader panel enter 00*NNN# for AR-721H item. 

    (2) One of many readers that connect with the controller must be set master reader. 

       The master reader panel enter 20*024 (default value) + 32 #  So, it is 20*56# for AR-721H item. 

    See Also: AR-721H User’s Guide, AR-727H User’s Guide  

 Select Write or Read. 

 Select to download/upload which card range. 

 Select to download reader type. 

 Click [ Start ] to download/upload user database. 

When system downloads successfully, at the bottom of the window will display the cards that 

download successfully. The system just downloads reader one by one; otherwise, it will download  

unsuccessfully. 
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5.4 How to set that user arrive single floor or multi-floor? 

Choose User Access Floor Edit under the Tools  drop down menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Other option: 
(1) Write this one: Write current user data to the reader.  

(2) Read Only It: Read back current user data from the reader. 

(3) Load: Open floor file. 

(4) Save: Save all the floor settings to the current work file. 

(5) Exit: Click exit to Quit. 

(6) Save To Text File: Save all the settings to a .TXT text file. 

(7) Load From Text File: Open TXT text file. 

  

 

 

 

 

 Select user number.   
 Select controller and reader node ID that 

manages that elevator. 
 Select the card user can access which floor.
 Click [ Write to Controller ]. 

 Select user number.   
 Select controller and reader node ID 

that manages that elevator. 
 Click [ Read From Controller ]. 
 Here will show that this user can access 

which floor. 
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5.5 How to see that user can access which door? 

Choose Available Door of User under the Tools  drop down menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

  

 Here shows department.   
 Here shows user number.   
 Here shows user name. 

 Here shows Employ ID. 

 Here shows Door Group. 

 Here shows the door number that this user can access. 

 

 

 Select the condition.   
 Assign door number range.   
 Click [ Yes ]. Then, the result is as follows.

 
For example, we would like to see that user 
number from 1 to 5.can access which door that
range from 0 to 31.  
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5.6 How to import / Export user database to/from Text file? 
5.6.1 How to import user database from Text file? 
The function supplies that the user database of other software import SOYAL software. 

Step 1: User database of other software is transformed into Text file.   

 

 

 

 

 

 

 

Step 2: Set data orders correspond to above information by choosing Import / Export Format of 
Card under the Tools menu item. As shown bellow: 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Step 3: Choose Import From Text File under the Tools  drop down menu. 

 

 

 

 

 

 

 

 For example, we arrange in  
order according to the above. 
The first field select [ A ].  
The second field select [ H ]. 
The second field select [ C ]. 
The second field select [ E ]. 
The others select [ M ] to skip. 

 Select Item space comma [ , ]. 
 Enter In/Export Card Range. 
 Click [ OK ] to save. 

 Select the source of importing 
data. 

 Click [ Open ], we will see the data 
of user number from 11 to 20 in 
the User Card Edit. 
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5.6.2 How to export user database to Text file? 

The function supplies that the user database of SOYAL software exports to Text file for the application 

of other software. 

Step 1: Set data orders as desired by choosing Import / Export Format of Card under the Tools  

menu item. As shown bellow: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Choose Export to Text File under the Tools  drop down menu. 

 

 

 

  

 

 

 

 

Step 3: Can go to default path C:\Program Files \ 701 Client, select fine name [soyal.txt ] and can see 
the result that user database transform as shown bellow. 

 

 

 

 

 

 

 Can arrange in order according 
to the demand. 

 The blank can write title as 
desired. 

 The blank can write title as  
desired. 

 Select Item space comma [ , ]. 
 Enter In/Export Card Range. 
 Click [ OK ] to save. 

 Enter File name. 
 Click Save. 

 



 

 20

5.6.3 How to detect that user database of other software has add/delete information?  
The function supplies that SOYAL software can detect when user database of other software has 

add\delete information.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For example as follows: 

  

(1) AUTO Import and Download at xx o’clock: Click this item and set at 9 o’clock. 

(2) The path: Default path 

(3) File name: Default name 

(4) Download to Controller while Import Data: Click this item. 

 
The result is the system will automatically detect file capacity of default file name of default path if 

there are changeable when it is 9 o’clock, if yes, SOYAL user database will change correspond to this 

database and download the data to the controller again. 
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6. Door Access Edit                                                               
6.1 Holiday Edit of Door Access  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     6.2 Door Name Edit 
Assign each Door Number (i.e. each reader) with a Door Name, max. 20 characters. Up to 255 

Door Names can be assigned. Door Number (i.e. Door Name) can be repeated. Usually, readers 

in same area can have same Door Number (Door Name) and it is good for Door Group Control. 

Door Name is shown in the history of Daily Transaction Record and for Door Group Control. 

Click on the toolbar Door Name Edit icon . As shown below: 

 

 

 

 

 

 

 

 

 

 

 

Click on the toolbar Holidays Edit icon . 
 

 Select year and month. 
 Click holiday. 
 Click [ Save ] to save the settings.  

    File name [ Default.hol ] 
 
Save As: Save all the Holiday Edit settings to    
         another file. 
Save Text: Save all the Holiday Edit settings to  
          a .TXT text file. 
EXIT: Click exit to Quit. 
Note that here are up to 120 holidays that can 

be set in a year starting from the editing date. 

 Select Range. 
 Enter door name. 
 Click Save. Save all the Door Names 

to the current work file. 
 
Save As: Save all the Door Names to

another file. 

Exit: Click exit to Quit. 
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6.3 Time Zone Edit 
     Time Zone defines a time range to allow a cardholder to access certain door(s) if this User 

Card’s Level is equal or above this Time Zone Level. 

On each controller, there are maximum 64 Time Zones, i.e. FREE (no Time Zone Control) and ZONE 

1 to ZONE 63. Each Time Zone can be linked to other Time Zones in series as a chain until a “END” 

showed up to end this chain, or end with a “FREE” to free Time Zone Control in the chain, i.e. no Time 

Zone Control. Click on the toolbar Time Zone Edit icon . As shown below: 

 

 
 
 
 
 
 
 
 
 
 
 

As: Save all the Time Zones settings to another file. 

Text: Save all the Time Zones settings to a .TXT text file. 

Exit: Click exit to Quit. 

 

 

 

 

 

 

 

 

 

 

 

 
 

  Enter time zone. 
 Select Time Zone number 01 ~ 63.
 Select to link which zone. If not, 

please select END. 
 Assign Time Zone Level. 00 ~ 63. 
 Select to indicate this Time Zone is 

also effectively on holidays. 
 Save all the Time Zones settings to 

the current work file. 

Select to download which time 
zone. 

 Select which controller. 
 Click [ Send ]. 

    Send current selected 

time zones to a 

821E/716E controller 

that selected and save 

to the current work file. 
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6.4 Door Group Edit 
Door Group consists of a door (i.e. a Reader or a Door Number) or a number of doors (i.e. a 

number of Readers or a number of Door  Numbers). A cardholder can access this or these 

door(s) if this User Card’s Level is equal or above this Door Group Level. System can assign up 

to 255 Door Groups, each Door Group consists of up to 255 doors. Each Door Group can be 

linked to other Door Groups in series as a chain until a “END” showed up to end this chain. 

Usually, doors with same characteristic can be grouped into same Door Group. 

Click on the toolbar Door Group Edit icon . As shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

For example, there are Sale Department (Door 2), QA Department (Door 3) and R & D Department 

(Door 4) in a company, to allow each employee to enter the main gate (Door 1) and his/her own 

department only. In editing, we can define Door 1&2/Door 1&3/Door 1&4 as Door Group 1/Door Group 

2/Door Group 3 respectively and link each Door Group to a “END”. 

    
    As: Save all the Door Groups settings to another file. 

    Text: Save all the Door Groups settings to a .TXT text file. 

Exit: Click exit to Quit. 

 

              

 Select Group Range. 

 Select Group number 001-255. 

 Check door that can pass. 

 Select to link which door. If not, please 

select END. 

 Assign Door Group Level. 00 ~ 63. 

 Save all the Door Group settings to the 

current work file. 
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6.5 How to edit different time zone for each door / each other? 
 
The function: Everyone can assign different time zone for each door. It is good for AR-716EV2 and 
AR-716Ei controller. The steps as follows: 

 
  
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
Or it will be easy for add / delete door group by already edit ok door group in door group edit. The 
steps as follows: 

 
 
 
 
 
 
 

 
 
 
 
   
 
 
 
 

 Select user number. 
 Select [ Set ] through drop 

down of Door Group. 
 Click this user that can 

access which door number.
 And select this door 

number is suitable for which
time zone through drop 
down. 

 Click [ Save ].  

 Select door group 001 through drop down. 
 Click [ Get ]. 
 Here will show door group 001 can access door, then you can add / delete door as desired.
 Click [ Save ]. 

 
Clear: Click        icon to delete all data that this user can access door 
Copy / Paster: To save edit time by copy / paster function. 
:
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6.6 Download data 

Click on the toolbar Download Data icon . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

 Download item 
(1) Clock: Download the computer Date and Time to all controllers. 

(2) Time Zone: Download all the Time Zones settings to all controllers. 

(3) Door Group: Download all the Door Groups setting to all controllers. 

(4) User Card: Download all the User Cards settings to all controllers. 

(5) Holiday: Download all the Holidays settings to all controllers. 

(6) All Items: Download all the above items to all controllers, no including Alias / Start Date. 

(7) Alias / Start Date: Download all the Alias / Start Date settings to all controllers. 

(8) Exit: Click exit to Quit. 

 Here will show download status. 

 Click which controller before download data. 

Note:  

1. The system will automatically download the PC Clock twice (10:00 and 23:57) a day as long as the 

701 Client is running, which can synchronize the timing between the PC and 701E Controller. 

2. Verify User Card Data After Download! : Once this item is chose. The system will double check if 

user card data is downloaded completely to the controller. 
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7. Transaction Record & Import/Export Format                                     
7.1 How to see Daily Transaction Record?  
When someone flash card, the system will automatically generate a Daily Transaction Record file 

with file name format YYYYMMDD.msg. Default path C:\Program Files \ 701 Server \ 

Click on the toolbar Daily Transaction Record icon . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The title is TRANSACTION RECORDS20021001.msg. 

 Look up forward. 

 

 Select fine name. 
 Click Open. As shown below. 
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 Look up backward. 

 Index is a serial number. XXXXE represent the message that comes from AR-701E, AR-716EV2,  

    AR-716Ei, AR-821EF or 829E controller. XXXXM represent the message that comes from the     

    system or 992E controller.  

 Show HH:MM:SS 

 As above, 001 represents controller Node ID and Soyal Hotel represents door name. 

 Show user number or login number. 

 Show user name or login name. 

 Show User ID (Equal to Employ ID). 

 Show department. 

 Show Status 

 Show detail description. If card is invalid card, window will show site code and card code. If user’s    

    access mode is card and P.I.N. But user enter error P.I.N. when user access, window will show    

    error P.I.N. 

Click on the toolbar Print icon . The report on the window will be automatically printed. 

7.2 How to see Multi-day Transaction Records? 

 At first, we go to Edits the view options  to set parameter such as card range, Start  

    Date / End Date, etc. For example, card range enter 1-2, Start Date select 2002/10/01 and  

   End Date select 2002/10/31. 

 Choose Multi-day view under File menu item as shown below. 

 The title is TRANSACTION RECORDS2002/10/01-2002/10/31. 
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7.3 How to transform transaction record to Text file for other software application?  
Our system is not good for three-shift working system, so cooperates with other software by this function. 
 
7.3.1 Transform into a TXT text file correspond to Daily Transaction Record format. 
(1) One day 

 At first, we must sure that the window display under Daily Transaction Record. Choose Save to    
    Text under the Tools menu item. 

 Then, this file saves into default path C:\Program Files \ 701 Client \ MSG20021001.txt  

(2) Multi-day  

 

 

 

 

 

 

 

 

 

 

 

 

 

 At first, we must sure that the window display under Daily Transaction Record. Choose Files 
to Text under the Tools menu item. 

 Enter Start Date and End Date as transformed. 

 Click Start. 

 We can go to the path C:\Program Files\701 Client, and click MSG20021001.txt. We will see 

the result that transform from Daily Transaction Record into a TXT text file. As shown above: 
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7.3.2 Transform into a TXT text file corresponds to designate format. 
Soyal software supports to set data orders correspond to the format that other software can 

accept. At first, we must sure that the window display under Daily Transaction Record. Choose 

Time Attendance Export Format under the Tools menu item. As shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 

 
This window separates into four sections. Fist section is transformable type, second section is data 
format, third section is data order and forth section is other setting. 
(1) Transformable type, there are many arrangement as desired. 

a. Set Begin Date / Ending Date: the system transforms data according to designate date range. 
b. Scheduled Daily Transfer at xx o’clock: Once this item is chose, and enters nine o’clock. 

When it is nine o’clock everyone, the system will automatically transform the transaction record 
after 9:01 am yesterday and before 9:00 am today into TXT text file. 

c. Run Time Transfer: Once this item is chose, When someone flash card, the system will 
automatically and immediately transform this transaction record into TXT text file. 

d. Fixed Output Pathname: Default path C:\Program Files\701 Client, if you want to change save 
path, you can click this item and select the path as desired.   

e. Fixed Output Filename: Click this item, and enter file name as desired. Then every day 
transaction will save in one file. Default filename is at the beginning of “ATT”, for example, 
20031001 for ATT20031001.txt 

f. Save Parameters: After setting parameter, If we don’t need to transfer it immediately. We 

can click Save Parameter to save. 
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Note: 
1. When you use “Scheduled Daily Transfer at xx o’clock” or “Run Time Transfer function” function,   
  please keep 701 Client is on status 
2. Don’t use together “Scheduled Daily Transfer at xx o’clock” and “Run Time Transfer function” function. 
 
(2) Data format, assign format content as desired. 

a. Date Format:  
b. Time Format 
c. Gregorian 
d. Reader ID 
e. Insert Character 
f. Duty Name (It is suitable for time attendance depend on function key. Can enter 8 characters) 
g. Card ID Format 
h. Weekday Table  
i. Leading String/Ending String 
j. User String (No limitation of entering character) 
 

(3) Data order, there are ten columns to be selected. 
a. Date 
b. Time 
c. Duty 
d. Reader ID 
e. Card #  (equal to Card ID) 
f. User ID (equal to Employ ID) 
g. Serial (equal to User number) 
h. VISA_ID (equal to ID card) 
i. Alias 
j. Name 
k. String  
l. Weekday 
m. Department 
n. Zone 

(5) Other function 
a. Transfer after Sorting: Once this item is chose, the system will transform first and last records   

according to user address order. 
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8. Monitor Setting                                                                
 
8.1 How to view user’s status at present for anti-pass-back?  
Function: View user’s status at present. It is good for the application of parking spaces. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose Anti-pass Map under the Setting menu item. 

 Select the controller. 

 Select Cards ranges.   

 Click Read. 

 After click the [ Read ], the mapping shows the current User Cards Inside or Outside or 

Unknown status, and the status of each card can be edited.  

 Show every symbol represents a meaning. 

 The status of each card can be edited. After editing, user can click [ Write ] to write it to controller. 

Reset: Reset all the 5000 User Cards to the [ Unknown ] status so it can go-out if inside and can 

get-in if outside. After reset, the system will write all the status to controller.  

Exit: Click exit to Quit.  
Note that if card is in Inside status, it can go-out. If card is in Outside status, it can go-in. If card is 

in Unknown status, it can either go-in or go-out, however, once it go-in/go-out, then after it can 

only go-out/go-in. 
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8.2 How to view DO / DI status on the controller?  
Choose Control Label under the Setting menu item. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8.3 How to view reader status monitor?  
Function: The system is on-line at present. We can view reader status. 

 

                                                       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Select the controller Node ID  

and reader Node ID. (Control    

name comes from the edit of  

control label under the Setting  

menu item) 

 Click [ Read Reader Status ]. 

 This will show Door Status and  

Arming Status. 

 Click Arming, Disarm, Open,  

Open All Door and Close 

according to the demand. 

    

Exit: Click exit to Quit. 

 

 Select the controller and enter 

controller name. (max. 19 characters)

 Here can enter DI / DO name and view 

DI / DO status.   

 Click Read / Save to view the result. 
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8.4 How to set release time of the reader one day? 

Function: Release time of time zone 63 is for all week, here release time is just for one day.    

For item no. AR-829E and up to Version 4.4 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
8.5 How to monitor multi-door access data? 
Function: The system can look up access records according to specific person.  

 

 

 

 

 

 

 

 

 

 

 

 

 
 

  

Click on the toolbar Reader Status Monitor 

 icon. 

 Select Controller Range. 

 Set to release time zone. 

 Click [ Run ] to execute immediately. 
 

Choose Monitor Format under 

the Setting menu item. 

 Enter the report title. 

 Enter field name and select to  

look up which door ( It can  

monitor 20 sets of in-door). 

 Enter field name and select to  

look up which door. (It can  

monitor 20 sets of out-door). 

 Click Yes. 
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As below, user number 0001 accesses 10 times in in-door that assign Door number 1, 2, 3 and 4 

on 2002/10/03.  

 

 Go to Edits the view options 

 to set card range, for  
example, card range enter 1-2.

 Choose User Status  

under the File menu item. 

As shown left. 

 Select fine name. 

 Click Open.  
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8.6 How to monitor reader status by dynamic floor plan? 
The function: This system supports true color dynamic monitor and import bitmap files for photos function.
 
I/O (Input/Output) describe as follows: 
 
(1) AR-701E/ AR-716EV2/ AR-716Ei multi-door controller 
      a. DO 00 – DO 15  (16 sets of relay output, for AR-701E) 
      b. K1 – K4    (4 sets of relay output) 
      c. DI 1 – DI 4   (4 sets of digital input)  
 
(2) Reader 
      a. DOR            (one set of digital input for door sensor) 
      b. ARM            (one set of digital input for arming)       
Note that each reader both has two sets of digital input for door sensor and arming. 
 

The following is the code for each monitor point: 
Monitor type Type Code The description corresponds to dynamic sub drawing 

Controller DO 00 DO 00 Relay output of the controller, picture no. 0 stand for OFF status, picture no. from 1 

to 5 recycle activated ON status.  

“ “ “ The same as above. 

Controller DO 15 DO 15 The same as above. 

Controller K1 DO 20 The same as above. 

“ “ “ The same as above. 

Controller K4 DO 23 The same as above. 

Controller DI-1 DI 24 The same as above. 

“ “ “ The same as above. 

Controller DI-4 DI 27 The same as above. 

Reader Node:001 DOR 32 Digital input of door sensor, picture no. 0 stand for door closed, 

Picture no. from 1 to 5 stand for recycle door open status. 

 ARM 32 Picture no. 0 stand for disarming status, picture no. 1 stand for arming status and 

picture no. from 2 to 5 stand for alarm status. 

Reader Node:002 DOR 33 Digital input of door sensor, picture no. 0 stand for door closed, 

Picture no. from 1 to 5 stand for recycle door open status. 

 ARM 33 Picture no. 0 stand for disarming status, picture no. 1 stand for arming status and 

picture no. from 2 to 5 stand for alarm status. 

“ “ “ The same as above. 

Reader Node:016 DOR 47 Digital input of door sensor, picture no. 0 stand for door closed, 

Picture no. from 1 to 5 stand for recycle door open status. 

 ARM 47 Picture no. 0 stand for disarming status, picture no. 1 stand for arming status and 

picture no. from 2 to 5 stand for alarm status. 

If the device is AR-829E / AR-821EF, whatever how many is Node ID, monitor code is both 32. It is 
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because that they are controller including RF reader. 
Step 1: Click the window of Default.pic on the below tool. As shown below: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 
 
 
 
Step 2: Choose New graphic under File menu item. 
Step 3: Choose Graphic content under Edit menu item. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Please draw floor plan through window’s paint in advance, and save file name into xxx.bmp 
 Click [ Brower ]. 
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 Here will show the path of floor plan. 
 Click [ ADD ] to add one monitor point. 
 Default value:  701E is 001 (controller Node ID), PpNum is 024 (monitor code), TYPE is DI (monitor 
type), FileName is DI (file name of dynamic sub drawing), Xpos is 10 (X-coordinates) and Ypos is 10 
(Y-coordinates)    
 Select monitor record through drop down. 
 Select [ NO ] through drop down in 992E(992E is another system, here don’t care about it) 
 Select controller Node ID. 
 Select monitor code in PpNum. 
 Select monitor type. 
 Enter File Name. 

    Every one pop picture make up of one floor plan (file name xxx.bmp) and many dynamic drawing.   
    Every dynamic drawing make up of 6 sets of sub drawing. File name of 6 sets of sub drawing  
    are the same, just difference is file name will follow up different number from 0 to 5, file name is   
    xxx.bmp and put these picture to default path C: \Program Files\ 701 Client\ popgra\  
    For example as follows: 
    Dynamic sub drawing make up of test0.bmp, test1bmp, test2.bmp, test3.bmp, test4.bmp, test5.bmp 

 Enter X-coordinates and Y-coordinates. 
 Click [ YES ] to save the setting. 

 
Step 4: Then choose Save As under File menu item to save one floor plan (file name xxx.bmp) and  
many dynamic drawing test0.bmp, test1bmp, test2.bmp, test3.bmp, test4.bmp, test5.bmp into one  
file (File name is xxx.pic) 
Step 5: Choose Pop Up Parameters under Edit menu item. 
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 Select [ XX ] through drop down in 992E. (992E is another system, here don’t care about it) 
 Select controller Node ID. 
 Select monitor code in PPs. 
 Select pop file name (File name is xxx.pic) 
 POP optional 

DI/DO - ON /Access: It stands for pop status once DI Close/DO On or open the door by flashing card. 
DI/DO – OFF/Alarm: It stands for pop status once DI Open/DO Off or alarm relay is active on the reader. 
AIO-LO/Egress: It stands for pop status once user accesses the door by pressing push button. 

 Click [ ADD ] to add one pop parameter. 
 Here will show parameter content. 
 Click [ SAVE ] to save the setting. 

 
For example, we would like to monitor the status once user accesses the door by flashing card or 
pressing push button in the first reader (Node ID 001) under AR-716EV2 Node ID 001. 
At first, we edit one floor plan and dynamic drawing door0.bmp, door1bmp, door2.bmp, door3.bmp, 
door4.bmp, door5.bmp in advance and put these picture to default path C: \Program Files\ 701 Client\ 
popgra\ 
 
(1) Floor plan quality 800X600, file name is 1F map.bmp 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(2) Dynamic drawing door0.bmp, door1bmp, door2.bmp, door3.bmp, door4.bmp, door5.bmp 

door0.bmp                 door1.bmp                      door2.bmp                
 
 
 

door3.bmp                door4.bmp                       door5.bmp   
 



 

 39

 
The steps as follows: 
Step 1: Click the window of Default.pic on the below tool. 
Step 2: Choose New graphic under File menu item. 
Step 3: Choose Graphic content under Edit menu item. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Please draw floor plan through window’s paint in advance, and save file name into 1 F map.bmp 
 Click [ Brower ]. 
 Here will show the path of floor plan. 
 Click [ ADD ] to add one monitor point. 
 Select monitor record through drop down. 
 Select [ NO ] through drop down in 992E(992E is another system, here don’t care about it) 
 Select controller Node ID [ 001 ]. 
 Select monitor code [ 32 ] in PpNum. 
 Select monitor type [ DOR ]. 
 Enter File Name [ door ].     
 Enter X-coordinates [ 460 ] and Y-coordinates [ 330 ]. 
 Click [ YES ] to save the setting. 

 
Step 4: Then choose Save As under File menu item to save one floor plan (file name 1 F map.bmp)  
And many dynamic drawing door0.bmp, door1bmp, door2.bmp, door3.bmp, door4.bmp, door5.bmp  
into one file (File name is 1 F map.pic) 
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Step 5: Choose Pop Up Parameters under Edit menu item. 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select [ XX ] through drop down in 992E. (992E is another system, here don’t care about it) 
 Select controller Node ID [ 001 ]. 
 Select monitor code [ 032 ] in PPs. 
 Select pop file name (File name is 1 F map.pic) 
 Select [ DI/DO - ON /Access ] and [ AIO-LO/Egress ] options in POP optional  
 Click [ ADD ] to add one pop parameter. 
 Here will show parameter content. 
 Click [ SAVE ] to save the setting. 

 
When the door located reader Node ID 001 is closed status, the window will show as follows:  
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When the door located reader Node ID 001 is open status through user access the door by flashing 
card or pressing push button, the window will show as follows: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For example, we would like to monitor arming/disarming/ alarm status of the first reader (Node ID 
001) under AR-716EV2 Node ID 001.  
At first, we edit one floor plan and dynamic drawing arming0.bmp, arming1bmp, arming2.bmp, 
arming3.bmp, arming4.bmp, arming5.bmp in advance and put these picture to default path  
C: \Program Files\ 701 Client\ popgra\ 
 
(1) Floor plan quality 800X600, file name is 1F map.bmp 
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(2) Dynamic drawing arming0.bmp, arming1bmp, arming2.bmp, arming3.bmp, arming4.bmp, 
arming5.bmp 
 
arming0.bmp               arming1bmp                        arming2.bmp                

 
 
 

 
arming3.bmp               arming4.bmp                       arming5.bmp   

 
 
 
 
 
The steps as follows: 
Step 1: Click the window of Default.pic on the below tool. 
Step 2: Choose New graphic under File menu item. 
Step 3: Choose Graphic content under Edit menu item. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Please draw floor plan through window’s paint in advance, and save file name into 1 F map.bmp 
 Click [ Brower ]. 
 Here will show the path of floor plan. 
 Click [ ADD ] to add one monitor point. 
 Select monitor record through drop down. 
 Select [ NO ] through drop down in 992E(992E is another system, here don’t care about it) 
 Select controller Node ID [ 001 ]. 
 Select monitor code [ 32 ] in PpNum. 
 Select monitor type [ ARM ]. 
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 Enter File Name [ arming ].     
 Enter X-coordinates [ 460 ] and Y-coordinates [ 285 ]. 
 Click [ YES ] to save the setting. 

 
Step 4: Then choose Save As under File menu item to save one floor plan (file name 1 F map.bmp)  
And many dynamic drawing arming0.bmp, arming1bmp, arming2.bmp, arming3.bmp, arming4.bmp,  
arming5.bmp into one file (File name is 1 F map.pic) 
 
Step 5: Choose Pop Up Parameters under Edit menu item. 
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select [ XX ] through drop down in 992E. (992E is another system, here don’t care about it) 
 Select controller Node ID [ 001 ]. 
 Select monitor code [ 032 ] in PPs. 
 Select pop file name (File name is 1 F map.pic). 
 Select [ DIO-OFF/Alarm ] options in POP optional.  
 Click [ ADD ] to add one pop parameter. 
 Here will show parameter content. 
 Click [ SAVE ] to save the setting. 
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When the door located reader Node ID 001 is disarming status, the window will show as follows:  

 
When the door located reader Node ID 001 is arming status, the window will show as follows:  

 

 
When the door located reader Node ID 001 is alarm status, the window will show as follows:  
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8.7 How to capture picture when user access the door in time by using DVR device?  
 
 

 The path of the picture   C:\program files\701 Client\Popgra\ 
    File name User0001.bmp stand for the picture of user number 0001. If there is no user  

picture stored in .bmp file, then another picture of the factory setting under the file name 

picture.bmp will shown for instead. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Click on the toolbar User Pictures icon . The picture of the card user will be shown  

on the upper right window on a fixed place. When someone flash card, the user picture will 

automatically be shown on the window as shown right above. 

     The user picture can also be viewed in Daily Transaction Record. Move pointer to the  

     row of the user access record and click twice, then the user picture will automatically be  

  shown on the window. 
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z Video Capture 
   This software supports capture function as shown right bellow.  

 On top of the window is shown the picture of card user.  

 On under of the window is shown the captured picture  

 that someone embezzle other card. 
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8.8 How to view temporary card status? 

If the operator wants to use this function, the project must have two doors. And assign door name in 
advance. We need to add @ symbol in front of door name of the in-door and add # symbol in front of 
door name of out-door so that the system recognize the data come from which one, in-door or out-door. 
For example, Door number 001 for door name “Gate-In”, please add symbol to become @ Gate-In, 
Door number 002 for door name “Gate-Out”, please add symbol to become # Gate-Out. 
 

 

Step 1: Click on the tool bar Door Name Edit icon   

to edit door name.  

 

 

 

 

 

 
Step 2: Choose Guest Status under the view menu item. 
Step 3: Then the Guest Status will add Index (user number) and time of this user when the user that 
take temporary card access the door. As shown below: 
 
 

 
 
Step 4: Then the Guest Status will delete Index (user number) and time of this user when the user that 
take temporary card go out. As shown below: 
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9. System / report parameter                                                    
9.1 701 Client’s system parameter  
Choose System Parameter under the Setting menu item. 

Please set system parameter as desired before starting to use 701 Client. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) ABA Card ID Format (32 bits): Once this item is chose, please enter ABA format in User  

   Card Edit, if this item is not chose, default value is Weigand format. 

(2) Error Message Confirm: Once this item is chose,  

   when card is invalid card or violates Door Group,  

   Time Zone, anti-passback as shown right.  

   The function is used for confirmation.  

   If user doesn’t confirm it, next access record  

   don’t show on the window. 

(3) Alarm Message Confirm: Once this item is chose, 

   When the door is opened by force or opens the door too long. 

   As shown right. The function is used for confirmation.  

   If user doesn’t confirm it, next access record don’t show  

   on the window. 
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(4) Show Detail Node Address: Once this item is chose, the station of Daily Transaction     

    Record will show controller Node ID, reader Node ID and door name. 

(5) Screen Saver Function and enter Wait Timer: Once this item is chose, it will have 

Screen Protection Function. 

(6) Popup Client at each message: Once this item is chose. If you reduce the window of 701  

Client to its smaller symbol, 701 Client’s window will auto-expand when there are new  

messages. 

(7) Time Attendance Settings: Select Weekly Table or Monthly Table in Attendance Edit. 

(8) Show Attendance in Report: Once this item is chose, there will be to show every time and 

attendance record in Multi-day Time and Attendance Reports. 

(9) Show Salary in Report: Once this item is chose, there will be to show salary data in 

Multi-day Time and Attendance Reports.  

(10) List Insurance in Month Report: Once this item is chose, there will be to show    

 Insurance premium in Multi-day Time and Attendance Reports. 

(11) Overtime Duty Base [ Min ]: default value is based on 30 minutes, for example, if   

 somebody has an overtime 00:22. However, in this system, the counting of the overtime  

hours is based on every 30 minutes, overtime that less than 30 minutes will be truncated. 

So, 00:22 is truncated to 0, so there is no overtime shown on the report. 

 When enter one minute, if somebody has overtime 00:22. However, in this system, the  

 counting of the overtime hours is based on every one minute. So, there will be overtime  

 22 minutes shown on the report. 

(12) Here can add/delete leave type: 

a. Leave item means if it will affect non-leave bonus when the staff ask for leave. 

b. Deduction item means if it will deduct salary when the staff ask for leave. (See Also: 

Salary Edit, Daily Time and Attendance Report) 

c. Report item means once this item is chose, there will be to show this leave type in 

Multi-day Time and Attendance Reports and Multi-day Time and Attendance Summary 

Reports. 

(13) Duty Hours Depends On Office Time or Real Off Duty Time: For example, if 08:30 on  

duty, lunch rest is 1.5 hours and 18:00 off duty. Tom works from 8: 03 to 18:30. If choose  

office Time, duty hours will show 8 hours in the report. If choose real off duty time, duty  

time will show 8:57 hours in the reports. 

(14) Overtime and insurance setting is for Taiwan. 
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9.2 Report system  
This menu function can select the view options for Door Access Control Daily /    

Multiday Transaction Record(s) or Time and Attendance Daily /Multiday/Summary Report(s). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the toolbar Edits the view options icon . 

(1) Department: For Transaction Record(s). 

(2) Specify Door: For Transaction Record(s). 

(3) Time: For Transaction Report(s). 

(4) Start Date/End Date: For Transaction Record(s) and Time and Attendance Report(s). Indicate  

that Transaction Record(s) & Time and Attendance Report(s) are limited in these periods. 

(5) Show Range Card Only: For Transaction Record(s) and Time and Attendance Report(s). Card  

  Only and Sorting are for Transaction Record(s). Ranges shown indicate that Time and  

  Attendance Report(s) & Transaction Record(s) are limited in these card address ranges, for  

  example, addresses from 0 to 12. 

(6) Show Similar String User.: Click this item and enter keywords in blank column. Then, the  

  searching result will be displayed in the reports. 

(7) Only Expire Parking Time: For Car Parking. 

(8) Time Sorting: For Transaction Record(s). If selected, all the events shown on the  

  transaction records are arranged in time sequence. 

(9) Abnormal Events Only: Click this item and select searching events as desired in the  

Abnormal Events. Then, the result will show in Daily Transaction Records or Multi-day 

Transaction Records. Can select the following events option: 
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a. Invalid Card 

b. Door Open Too Long 

c. Fingerprint Identify Fail 

d. Expiry Date 

e. Force Entrance 

f. Access Between A, B, C and D 

g. Flash Interval too Short [min] 

h. Moniting Time Zone 

(10) Options of report: For Time and Attendance Report(s). 
a. Skip while user name is empty: If there is no user name in User Card Edit, the report 

for Daily Time and Attendance Report and Multi-day Time and Attendance Reports will 

not show the data of this user number. 

b. Skip invalid user: If the access mode of the user is invalid in User Card Edit, the report 

for Daily Time and Attendance Report and Multi-day Time and Attendance Reports will 

not show the data of this user number. 

c. Skip empty record of MonRep: lf there are not transaction record someday, it will not 

show this day in the Multi-day Time and Attendance Reports. 

d. Skip empty record of MonRep: When user overtakes expired date, it will not show this 

day in the Multi-day Time and Attendance Reports. 

e. Delay On Duty: Once this item is chose, it will only show delay data in the Daily Time 

and Attendance Report. 
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f. Early Off Duty: Once this item is chose, it will only show early data in the Daily Time and 

Attendance Report. 

g. NEGL Duty: Once this item is chose, it will only show absence data in the Daily Time and 

Attendance Report.  

(11) Search Conditions: For Car Parking 
  a, Antipass-back Error 

  b. TimeZone Error 

  c. Door Group Error  

Step1: Click on the toolbar Edits the view options icon . 

Step2: Set parameter as desired, for example, Start / End Date, Specify Door, Card Range, etc.  

If you want to see which somebody to violate Antipass-back, please check Antipass-back Error.  

If you want to see which somebody to violate Door Group, please check Door Group Error.  

If you want to see which somebody to violate Time Zone, please check Time Zone Error. 

Step3: Choose record search under the File menu item. 

Then you will see the result that look up. 

The example is as follows: 

 Set Start Date 2002/07/01, End Date 2002/08/31, Card Range 3-3, check Anti-pass-back 

Error, click Forward Search. The result is as shown bellow. 

San violated Anti-pass-back in 2002/08/07, and San access normally in 2002/08/06. Therefore, 

the interval between 2002/08/07 and 2002/08/06 is 27 hours and 18 minutes. To utilize this 

concept analogizes others. 
 

 

 

 

 

 Set Start Date 2002/07/01, End Date 2002/08/31, Card Range 0-0, check Time Zone Error, 

click Forward Search. The result is as shown bellow. 

San violated Time Zone Error in 2002/08/07, and San access normally in 2002/08/06. Therefore, 

the interval between 2002/08/07 and 2002/08/06 is 26 hours and 51 minutes. To utilize this 

concept analogizes others.  

 

 

 

 

 Set Start Date 2002/07/01, End Date 2002/08/31, Card Range 0-0, check Door Group Error, 
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click Forward Search. The result is as shown bellow. 

San violated Door Group in 2002/08/07, and San access normally in 2002/08/06. Therefore, the 

interval between 2002/08/07 and 2002/08/06 is 26 hours and 43 minutes. To utilize this concept 

analogizes others. 

 

 

 

 

(12) Forword Search / Reserve Search 

(13) Only Leave User In Summary Report: For Multi-day Time and Attendance Summary 

 Reports. For example, I want to see the information whose are late and early card range  

    from 1-5 on Oct. 01-10, 2002. The steps is as follows: 

Step 1: Set parameter as desired, for example, Start / End Date, Card Range.  

Step 2: Click Late and Early item in Only Leave User In Summary Report. 

 Step 3: Click on the tool bar icon Multi-day Time and Attendance Summary  

    Reports . Then, the result will show as follows: 
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10. Attendance & Salary                                                       
10.1 Holiday Edit of Time Attendance 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

     
 10.2 Attendance Edit 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the toolbar Attendance Edit icon . 

     Select group. There are up to 50 sets of Office Hours settings. Operator can assign a group  

        name for each Office Hours setting. There are max. 20 characters for the group name. 

Click on the toolbar Holidays Edit icon . 
 

 Select year and month. 
 Click holiday. 
 Click [ Save Office Day ] to save the settings. 

 
Save Text: Save all the Holiday Edit settings to  
          a .TXT text file. 
Read Office Day: Read holiday information of Time
Attendance from file name [ yyyyDuty.wth ] 
EXIT: Click exit to Quit. 
Note that here are up to 120 holidays that can 

be set in a year starting from the editing date. 
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 Select flex time. 

  Enter respectively On Duty, Break Out, Break RTN, Off Duty, Over Time.  

 Click [ Save ]. 

 

Save: Save all the Office Hours settings to the current work file. 

Save As: Save all the Office Hours settings to another file. 

Text: Save all the Office Hours settings to a .TXT text file. 

Exit: Click exit to Quit. 

� Advanced statement 
(1)  The flexible time setting for the ON/OFF Duty hours. If Group Office, there are 15 minutes  

flexible time setting and the lunch rest is 1.5 hours. The employees of this office hours setting can 

go to office between 08:15 and 08:30 without late. For example, if 08:30 on duty, shall 18:00 off 

duty without late and early; if 08:21 on duty, shall 17:36 off duty without late and early; If 08:32 on 

duty, and if off duty on 17:59/18:00/18:01, then there is “2 minutes late and 1 minute early’/”2 

minute late and no early”/”2 minute late and no early” respectively. 

(2) The starting of overtime hour. If the user select First and Last Record in the Time Attence 
Menu of 701 Server, the system will automatically delay the overtime starting time for a 

certain period of time if employee was late on duty for a certain period of time during  

   office hours. There are two types of Time & Attendance that selected in the Time   
   Attence Menu of 701 Server. As followings: 

First and Last Record: The system will treat the first record (first record after 4:00AM) and 

last record (last record before 3:59AM next day) of the day as employee TIME-IN and 

TIME-OUT respectively. 

Depend on Function: There are Function Keys on the reader and can set Regular Hours 

TIME-IN/TIME-OUT, Overtime TIME-IN/TIME-OUT, Lunchtime TIME-IN/TIME-OUT … etc.    
Note: The system will count only one TIME-IN or TIME-OUT if an employee TIME-IN or 

TIME-OUT many times with same Function Key within 5 minutes, and the first TIME-IN or 

TIME-OUT will be the choice. If someone press wrong Function Key by mistake, within 5  

minutes, it can be overridden by just press the right Function Key and TIME-IN or 

TIME-OUT again. The Function Keys will be displayed on the right-most LCD. 

The software doesn’t support 3 shifts, however, it provides with overnight function. The 

on-duty time will be treated as same day if the TIME-OUT is over 24:00PM and before 

03:59AM next day. 
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10.3 Salary Edit 
      
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AR-829E 
AR-821EF 

Screen Function Display 

F1 Duty:0 

F1 twice BRK:0 

F2 Duty:0  

F2 twice BRK:F 

F3 OUT:0  

F3 twice GO OUT 

F4 OUT:F   

F4 twice RETURN 

Choose Salary Edit under the Setting menu 
item. 

 Select User. 
 Enter user salary data according to  

   demand. Note that lunch allowance can be 

   calculated on unit time a day. 

   Which user goes on duty before AM11:00 

   and goes off duty after PM14:00. 

   The setting of health Insured Value,    

   Insured Family and Labor Insured      

   Value are related with the setting of   

   System Parameter’s Insurance value 

   Table. 

 Can enter other data that there is not in  
 right field. 
 Enter User birthday, Take office and   

    Leave office. 
 Click OK to exit. 

Exit: Click exit to Quit. 
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10.4 Salary Copy & Paste function 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 Select copy user as desired. 

 Click [ Copy ]. 

 Select paste user as desired. 

 Click [ Paste ]. 
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11. Attendance Reports                                                      
  

11.1 How to edit Report Title? 

 
 

 
 
 
 
 
 
 
 
 

Choose Report Title under the Setting menu item. 
 Support two rows title can be entered  
  Select the format as desired. 
 Click [ Yes ] to save the settings. 

 Open the report. For example, click on the tool bar Daily Time and Attendance Report icon . 

 Then, click on the toolbar Print icon . The report on the window will be automatically printed. 
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11.2 Open Report Order 
Basic concept: The reports are not opened in order, and the information will appear error. 

Step 1: Open Daily Time and Attendance Report. 

Step 2: Open Multi-day Time and Attendance Reports. 

Step 3: Open Insurance Summary Report. 

Step 4: Open Multi-day Time and Attendance Summary Reports. 

Note: 

(1) Open Daily Time and Attendance Report one by one and check if there is error. 

(2) Open Multi-day Time and Attendance Reports, and the system will automatically calculate 

salary and insurance premium (for Taiwan). 

(3) Open Insurance Summary Report, the system will automatically calculate various burden  

 expenses (for Taiwan). 

(4) Open Multi-day Time and Attendance Summary Reports, the system will automatically  

 calculate the summary hours of Duty, Early, Late, etc. 

 
11.3 How to view Daily Time and Attendance Report? 
When someone flash card, the system will automatically generate a Daily Time and Attendance 

Report file with file name format yyyymmdd.dut 

 
 
 

 

 

 

 

 

 

 

 

 

As above, we can tell that there are about eight entries for user number0001 during a day. The 

system automatically treats first entry as TIME-IN and last entry as TIME-OUT, and records the 

others last six entries as reference if not consider the last entry 20:10. 

Click on the tool bar Daily Time and 

Attendance Report icon . 
 

 Select fine name. 
 Click Open. 
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For the Time and Attendance Report, the system will report only one entry if there are many 

entries made within the same minute. For example, if entries made on 8:31:07, 08:31:23 and 

08:31:59, there will be only one entry report on the Time and Attendance Report. However, there 

will be three entry reports on the Daily Transaction Record. 

 After opening Daily Time And Attendance Report, the title of the window will show DAILY    

 TIME AND ATTENDANCE REPORT 20021001.dut. 

 Look up forward. 

 Look up backward. 

 Click row twice can enter the editing. For example, if we click row San twice, a menu as   

  below is shown: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The user number is modified at present on the window. 

 Modify working hours of the employee. All the Time & Attendance data for San can be modified. 

The [ OVT On, OVT Off, Break and Return ] can be modified only when Attendance type of 

701 Server select Depend on Function type. 

 Select Case through the drop down when the employee asks for leave.   

    The system provides 2 leaves one day, for example, CASU in the morning, DUTY in the   

    afternoon. And enter Leave Hours, it will be related with leave deduction of salary table. 
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To add / delete leave type can be set in System parameter under the Setting menu item.  

(See Also: System parameter) 

Option Description Option Description 

DUTY Authorized Leave CASU Personal Leave 

SICK Sick Leave SPEC Vacation Leave 

BZTP Travel On Business   NEGL Absent 

MATE Maternity Leave COMP Bereavement 

Other Other Leave Leave Resignation 

 

 Fixed Record: Click this item; it will lock modification data of this user. Otherwise, once    

  execute Reflash function . All settings go to original status.    

 Re-calculated, updated and exit. If selected, the field Late, Early, OVT and Case will be  

re-calculated and updated automatically based on the change of the field On, Off, OVT On, OVT 
Off, Break (Lunchtime TIME-OUT) and Return (Lunchtime TIME-IN). 

 Updated and exit. If selected, the field On, Off, Late, Early, OVT and Case will be updated. 

If we check the row of San, his office hour is between 08:30 ~ 17:30 with 15 minutes flexible time, San 

comes to office at 08:50, so there is 00:05 (08:50 minus 08:45) hour late and the system will 

automatically count the overtime starting from 17:50. He leaves office at 18:12, so there shall be an 

overtime 00:22 (18:12 minus 17:50). However, in this system, the counting of the overtime hours is 

based on every 30 minutes, overtime that less than 30 minutes will be truncated. I.E. 00:22 is truncated 

to 0, so there is no overtime shown on the report. 

 The correlation between Daily Time and Attendance Report and Reflash Daily Time and 
Attendance Report: 
At first, there are attendance records, then the system will generate Daily Time and Attendance Report 

and count automatically attendance result according to Attendance records. 

Click on the toolbar Reflash Daily Time and Attendance Report icon . 

This function applies for after Daily Time and Attendance Report had been run. Attendance Edit is 

only modified. We just open Daily Time and Attendance Report and click  one by one this moment. 

Attendance result of new Daily Time and Attendance Report will be counted according new 

Attendance Edit. 

 The system has these figures for user’s recording convenience. 

    The figure  stands for that Daily Time and Attendance Report is not modified by the user. 

    The figure  stands for that Daily Time and Attendance Report had been modified by the user. 

    The figure  stands for that the user is modifying Daily Time and Attendance Report. 
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11.4 How to arrange leave in advance? 
For example, San submit on 2002/10/01 for the personnel department that will ask for Personal Leave 

on 2002/10/16. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 When we open Daily Time and Attendance Report on 2002/10/16, everyone’s attendance status  

is absent. It is because that for the day on 2002/10/01, 2002/10/16 is the future, everyone don’t yet 

go to work. Everyone goes to work until 2002/10/16, the system will be attendance    

    records instead of absence. 

 Click row San twice, a menu as below is shown: Please select leave type and enter leave hours. 

 Click OK. 

 The system displays CASU in the leave of San.  

 

 

 

 

 

 

 

 

 

 

The personnel department can edit San leave in 

   advance in Daily Time and Attendance  

   Report. For the day on 2002/10/01, 2002/10/16  

   is the future, so there is not 20021016.TXT file 

    name. Therefore, we must enter 20021016 in  
    file name in advance. 

 Click [ Open ]. 
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11.5 How to view Multi-day Time and Attendance Reports? 

 At first, we go to Edits the view options  to set parameter such as card range, Start    

    Date / End Date, etc. For example, card range enter 1-1, Start Date select 2002/10/01 and  

   End Date select 2002/10/31. 

 Click on the toolbar Multiday Time and Attendance Report icon . As shown below. 

 The title is MULTIDAY TIME AND ADDENDANCE REPORTS 

   2002/10/01-2002/10/31 (0001:TOM 1002 SALES). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remark: 

1. The system opens just 30 Multi-day Time And Attendance Reports once when the operator      

  don’t set card range.     

2. Each of the Daily Time and Attendance Report Files in these multi-day periods has to be  

  opened once, otherwise, the Multi-day Time and Attendance Reports will skip the Daily Time  

  and Attendance Report that never opened before. It is user responsibility to open each Daily 

Time and Attendance Report once. 
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11.6 How to view Insurance Summary Report (for Taiwan)? 

Basic concept: Open Multi-day Time and Attendance Reports, and the system will automatically 

calculate salary and insurance premium. In other words, if Insurance Summary Report opens earlier 

than Multi-day Time and Attendance Reports, Insurance premiums show zero in Insurance Summary 

Report. 

 At first, we go to Edits the view options  to set parameter such as card range, Start  

Date / End Date, etc. For example, card range enter 1-5, Start Date select 2002/10/01 and End 

Date select 2002/10/31.  

 Choose Insurance Report under the File menu item. As shown below. 

 The title is SUMMARY REPORT OF INSURANCE 2002/10-2002/10 
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11.7 How to view Insurance Summary Report? 
Function: The application of annual reports. 

 At first, we go to Edits the view options  to set parameter such as card range, Start 

Date / End Date, etc. For example, card range enter 1-5, Start Date select 2002/01/01 and 

End Date select 2002/12/31. Click Late and Early item in Only Leave User In Summary 

Report. 

 Click on the toolbar Multiday Time and Attendance Summary Reports icon  as shown 

below. 

 The title is Multiday Time and Attendance Summary Reports 2002/01/01-2002/12/31. 
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11.8 How to transform Time and Attendance Report to Text file? 
Now, the system supports two file name, one is Text file, the other is cvs file for Microsoft Excel 

application. For example, Daily Time and Attendance Report on 20021001. 

At first, we must sure that the window display under Daily Time and Attendance Report. 

(1) Text file 

Step 1: Choose Save To Text under the Tools menu item. 

Step 2: Default file name DUT20021001, file type “txt”, and default path C:\program files\701 Client\. 

Step 3: We can go to the path C:\Program Files\701 Client, and click DUT20021001.txt. We will see the 

result that transform from Daily Time and Attendance Report into a TXT text file  

 

 

 

 

 

 

 

 

 

 

(2) cvs file for Microsoft Excel application 

Step 1: Choose Save To Text under the Tools menu item. 

Step 2: Default file name DUT20021001, file type “txt”, and default path C:\program files\701 Client\. 

Step 3: We can go to the path C:\Program Files\701 Client, and click DUT20021001.txt. We will see the 

result that transform from Daily Time and Attendance Report into a TXT text file 
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12. Project Files Management & Backup                                           
 
12.1 Project Files Management 
Choose Project File under the Setting menu item. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For each menu’s settings, the 701 Client software can assign a file to save all the settings. And 

collect all these files under a same project; system can also assign a project name to it. Once 701 
Client software installation is completed, the default filenames of Project Name, User Card menu, 

Door Group menu, Time Zone menu, Holiday menu, Attendance menu, Door Name menu, Access 

Level, and Salary are “default.set”, “default.usr”, “default.grp”, “default.zon”, “default.hol”, “default.wrk”, 

“default.dor”, “default.acc”, and ‘default.sly” respectively. For each individual project, operator can 

change those default filenames to the names that they want by just clicking the “As” button of each 

menu to save to another filenames. In the Project Files menu, click the button in the left to select that 

filename of each menu, and then click “As” button to save all the selected filenames to another 

Project Name. Afterwards, The new Project Name and new files will be acted as work files.  

Parameter Path: A path that saves the files of menu settings. The path is user-defined, normally, it is 

in path C:\program files\701 Client\ . 
History Path: A path that saves Transaction Records File (*.msg) and Time and Attendance Reports 

File (*.dut). The path is user-defined, normally, it is in path C:\program files\701 Server\. 
Save As: Save all the selected files to another Project Name. 

Load: Load a new existing project. 

Save: Save current Project Name and all the selected files as work files and exit. 
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12.2 Backup 

Function: It is good for software update or the data recuperates when the data of the system is 

damaged. Choose Backup under the Setting menu item. 

 

(1) Backup                                        

 

 

 

 

 

 

 

 

 

 

 

(2) Restore 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Select the path of the backup. 
 Show the path of the backup. 
 Click Backup to start backup action.

 

 Select the path of the Restore. 
 Show the path of the Restore. 
 Click Restore to start Restore action.
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13. Other information                                                          
 
13.1 Font 
Function: Change word type and size of the report. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As above, word size and type of 
the report is 9 size, standard and 
Times New Roman. If we think 
that the words are too small not 
to see. We can choose Font 
under the View menu item to 
change them as shown below. 

Word size and type of the report is 15 size, 
boldface and Arial after modified. 

Word size and type of the report is 12 size, 
Regular and Times New Roman in original. 
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13.2 Change the frame that enters 701 Client software 
Function: Show company logo instead of default frame. Give an example as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As above, this frame is default. We would like that below picture substitutes for default.  

 

 

 

 

 At first, we save above logo【Client.bmp】 

 Then we paste[ Client.bmp ] to C:\program files\701 Client\ . 

 Enter 701 Client again. The frame will show company logo instead of the default. 

 

 

 

 

 

 

 

 

 

 


